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Cviceni 2

Vicerozmerné normalni rozdéleni
a vicerozmerny t-test
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Vicerozmerne normalni
rozdéleni
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Frequency
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Histogram Hustota jednorozmérného
normalniho rozdéleni
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Motivace — pokracovani

Dvourozmeérny Hustota dvourozmérného
histogram normalniho rozdéleni




Vicerozmeérné normalni rozdeéleni

Hustota jednozmérného normalniho rozdéleni:

1 (x —p?
f(X) — ,—(27_[)0_2 " exp <_ 252 )

L - stfedni hodnota 02 — rozptyl

Hustota vicerozmeérného normalniho rozdéleni:

F 550 = —— ( ~(x— )T 27 ))
X1, e, X) = cexp|l —=(x—u X— U

v TR\ 2

I - vektor stfednich hodnot X - kovarianc¢ni matice

Hustota dvourozmeérného normalniho rozdéleni:

1 exp [ - 1 (z — pz)? L= i) 2p(x — pa)(y — pty)
2no,0y/1 —p% 2(1 — p?) o2 o2 020 1

Yy
[ 5 o2  po.o, p - korelace meziXay;
2 T - \po.oy O, o — smérodatnd odchylka

flz,y) =

¥
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Hustota u nekorelovanych a korelovanych proménnych

Nekorelované proménné
(I"ll = Hz = OI 0-]_ = 02 =1;
p=0)

Korelované proménné
(I"ll = IJ-Z = OI 0]_ = 02 =1;
p=0,5)

Xl MU e,
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Vicerozmeérny prumeér a kovariancni matice

e vicerozmérny primér (napf. pro datovy soubor se 2 proménnymi):

[1 n 1o
LY 1T

* vybérova kovarianéni matice (napf. pro datovy soubor se 2 proménnymi):

S11 Si12
s:[

1
kde s{; = — Y (X1 — Xq)?
So1 SZZII 11 n— l—l( 1 1)

1

MU ‘:_‘\\L.,.’%
IBA lw



Vypocet rozptylu a smérodatné odchylky - opakovani
L

* Priklad ctvercl odchylek od priiméru pro n = 3.
* Rozptyl je mozno znacné ovlivnit odlehlymi pozorovanimi.

Rozptyl:

1 _
§°=—"——) (x —X)°
n—1iZ:1:

Smeérodatna odchylka:

0,269 0,547 0,638 0,733

X, X X, X3

.........
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Ukol 1

* Spoctéte vicerozmeérny prameér a vybérovou kovariancni matici pro soubor
3 subjektd, u nichz byly naméreny hodnoty objemu hipokampu a
mozkovych komor, pficemz namérené hodnoty byly zaznamenany do
nasledujici datové matice:

2 12
: 10}

3 8

X =
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Ukol 1 - feéeni

13¢

Objem Objem g |
ID . ’ S 12 °
hipokampu mozkovych komor = N
g
1 2 12 3 10 X o
4 10 2 ol
3 8 GE_J, 8 °
o)
@) 7 !
1 2 3 4 5
Vicerozmeérny primeér: Objem hipokampu

X an 1zn ] [1 2+ 4+3) ~(12+10 8] [3 10]
X= - X' - X' = — — —_—
n i1 i1 n i1 i2 3( + 4 + ) 3( + -+ )

Kovariancni matice: S = ] kde:

1521 S22
s11= 5 S (in —%)? = 55 (232 + (4=3)2+ (3-3)2) =7 (1 +1+0) =1
= %12?=1(Xi2 —X)° = 3Tll((lz —10)24 (10— 10)2 + (8 — 10)?) =4
1

_ _ 1
S21 = 512 = ;3 i1 (X1 — X)X — Xp) = a((z —3)(12-10) + S5S = [ 11 _41]
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Ukol 1 - doplInéni

. v V4 . . Sll
Kovariancni matice: S = S
21

v 7 . r
Korelaéni matice: R = lrll
21

r =T = = =
e VS11 /S22 V14

z;ﬂ - L11 _41]

I‘12] _ [ 1 —0,5]
r,l — [—0,5 1

S12 —1

—0,5
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Ovéreni dvourozmerné normality

Bagplot = ,bivariate boxplot” (tzn. ,dvourozmérny krabicovy graf“)

120

110+

100 | «

90

vaha

80 +

70 F *

60 o

E'D B FrEn

4[}150 15;5 1:50 1é5 1::'0 1::'5 1én 18IE 1§n 155 200 © ¥aha
m Median

wyska 4 Cutliers

v softwaru Statistica: Graphs — 2D Graphs — Bag Plots

L v i¥and ‘.._"ILI
Koritakova: Vicerozmérné metody - cviceni IBA lw 16



Ovéereni dvourozmerné normality

vaha

’ \4 7 . ll . .
Vykresleni regulacni elipsy (,,control” elipse):
120
110 | ©
100 | e o ~
- o \\
_ o ] @
80 ¢ 0" g o = 5 /
o B QEB o ;‘
[}
80 ¢ o gu ° gog a
[+] o [+ ] a
o a
70+ oo 9 o @ oo o
8 o o g%, o
Dc DED o
60 | o B° o°B g
cg oo /
501 oo 2 ..x"'aj.
"‘\\ o] c:__ -
40 | -
0 : : : :
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wyska

v softwaru Statistica: Graphs — Scatterplots — na zalozce Advanced zvolit Elipse Normal
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Normalizace dat

e Pfevod na normalni rozdéleni (normalita je predpokladem rady
statistickych test().

* Napr. logaritmicka transformace: X = In(Y) nebo X = In(Y+1), pokud data
obsahuji hodnotu O

Asymetrické rozdéleni Normalni rozdéleni
fly) f(x)
X =In(Y)
>
Median
-5 (o £
Geometricky primér y Median Pramér In (y)

* Dalsi priklady:
— odmocninova transf. (pro proménné s Poissonovym rozlozenim nebo
obecné data typu pocet jedincu, bunék apod.: X = JY neboX =Y +1
— arcsin transfomace (pro proménné s binomickym rozlozenim)

— Box-Coxova tranformace e
ea W



Dalsi typy transformaci vicerozmérnych dat

standardizace dat

min-max normalizace

centrovani dat

odstranéni vlivu kovariat na jiné proménné

MU ‘:_‘\\L.,.’%
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Standardizace dat

e dlvod: prevod proménnych na stejné méritko

* standardizace: z; = xi;x (tzn. odecteni priiméru od jednotlivych hodnot a

podéleni smérodatnou odchylkou)
 promeénné budou mit rozsah priblizné od -3 do 3

e ziskame tim soucasné i tzv. z-skore (které vyjadruje, o kolik smérodatnych
odchylek se i-td hodnota odchylila od priméru)

e pozor: standardizace je nevhodna v pripadé, kdyz proménné nemaji
normalni rozdéleni a kdyz se v datech vyskytuji odlehlé hodnoty!!!

14000 5 ¢
12000 | £3 & g i
10000 | 51
8000 | 1L
soo0 | O —> 0f E
4000 | & ETT‘U ; [
2000 | 3 3l
0 ————— 4 —
=] [] [=] o [=] I=] =] ] [=] o [=] I=]
}I }l }l }l }l “.'-'I }I }l -“-"I }l }l “.'-'I
2 & 2 E §5 I s ® % E § 3
e g E E o a 4 E E o
E 2 8 2 8§ 5 o 5 2 & 2 8§ 3 Medi
x = o [T o Median x = o [T o Median
2 & F T2 25%75% 2 & F T2 [O025%75%
T T Min-Max T T Min-Max

"y ZoN/7 v 4 _ Hp 1 .. : ’;
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Min-max normalizace

e davod: prevod proménnych na stejné méritko

e oproti standardizaci vhodna i na proménné nemajici normalni rozdéleni Ci

obsahujici odlehlé hodnoty

* min-max normalizace: y; =

x;j—min(x)

max(x)—min(x)

* rozsah hodnot proménnych po min-max normalizaci je od 0 do 1

14000
12000 ¢
10000 ¢
s000
6000 +
4000
2000

T © © © © ©
> = > = > =
[ L Y i |
HTII!'EI'."JEIZ'D
2 & g 3 & =
=
E 2 8 2 5 °
T m 5 =
P EE T2 3
o
T

2

o Median
0 25%-75%
T Min-Max

12 ¢
1.0
0.8t
HERENRRE
[m]
o B H W H g
02}
0.0 ¢
_Dlz i i i i i i
E £ £ E E S
2 2 2 2 2 2
ad o = = < o Median
= g £ =& 2 3 [ 25%-75%
= = T Min-Max
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Centrovani dat

odecteni priméru od dat — ziskdme novou proménnou, ktera bude mit
primér roven nule

divod: centrovani je dulezitou podminkou nékterych pokrocilych
statistickych metod (napt. klasifikaCnich)

centrovani: z; = x; — X

14000 | 3000 ¢

12000 } 3 = 2500 f

10000 | fggg'

8000 | mnn:

gooo| O =) 500 |

4000 | = ETTU ol H

2000 | 5 500 t

_ -1000

EI EI ’?W g| E| _EI 1500
2 8 g E g5 3 2000
e 8 E 8 E & tE € £ £ £ €£
FRo= ® o= o= - s & & & & 8
g E £ o & 3 o Median g T A T B o Median
g = = []25%-75% = g 8 ® 3 8 (] 25%-75%
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Odstranéni vlivu kovariat (tzv. adjustace)

=

V prvnim kroku definujeme regresni model vztahu kovariaty (napf. véku) a dané proménné
Pro kazdého pacienta je vypocteno jeho reziduum od regresni primky

Reziduum (predstavujici hodnotu parametru po odecteni vlivu véku, jeho primér je 0) je
pricteno k primérné hodnoté parametru

4. Vysledna adjustovana hodnota ma odecten vliv véku, ale zaroven neni zménéna Ciselna
hodnota parametru

(-] V4 . ’
Puvodni data Adjustovana data
R = S =
e e ] Ve e ] Ve
T T T T I T I | T | | | T |
20 30 40 a0 B0 70 g0 Objem komor 20 30 40 50 B0 70 80 Objem komor
L a * a
| - S
g | L™ e ¢ | é cé " . LI o 2
. * ™ I I o T b 2PY o T i _:_
S Seant 0w L o Seine * . L
i * et .:..:.O o%.:= .: '0‘ * i | é .‘.. .':“:? \:°3 "“ . i i
g ;g.' ...:;“ Shéf;. . vy H . g 0&.&.’:‘03.3 :0’3‘ .to3“. ., i i
— b AN Nt =4 ; - A = TLVEELY M TN = !
3 ?y&:.’;&%ﬂ":ﬂ ~ . i ;j:r. ’;’;" ﬁgza 3 £Re . 7 o
A - AR o : .
8 ‘ﬁ'*i - A“'. .‘.. ' * ..' | ! 8 a., i?g‘“. % '.é; .... - !
e | ’o/.' :2‘U: * 3 .:... o, w | i BN £ v | ¢ ..00.. KPS A :10.... +e ’0 v w0 i i
E {‘. :.: .: .0 . * * a : E .’. ': - .: .’& . w? °. bl * * : P
o R . . . : o AN * . . '
_g Wt e, 4. '_Oa . e T e . - .
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Transformace dat pomoci softwaru SPSS |

* Logaritmicka transformace:

Transform -> Compute Variable -> Target Variable: ndzev nové proménné (napr.
vaha_log) -> Function group: Arithmetic -> Functions and Special Variables: vybrat
Ln a pretahnout do okna Numeric Expresssion -> do argumentu funkce vioZime
vybranou proménnou (napr. vaha)

& Genc transformovana

)

=]
) ()

&a Gender_rek I l {

&5 gender_01
& Height {

1
%

J el e Ji)
J =)o) | @&

& Age
& Height_cor

& Weight

& weight_konst
& MMSE

& MMSE_24

& mmse_neg

L. mmea_kat P

LN(numexpr). Numeric. Returns the base-e logarithm of
numexpr, which must be numeric and greater than 0.

Popis vybrané funkce

@(optional case selection condition)

[ ok ][ paste || Reset |(cancel| [ Help |

;_.Lj Compute Variable e
Nazev nové proménné
Target Variably Numeric Expression:
|Weight_log | - [(Nowveignt) ¢mmmmm Definovaninové
promeénné

Type & Label...
&1 3 ¢ Kalkulagka”
&> Group =
&b Group_3kat . " Function group:
3 o LEEOEE | :
&b aoup . . . Arithmetic
& arou; Vybér promenné, E | 4 5 6 CDF & Noncentral CDF
& agrou; ktera ma byt Conversion

Current Date/Time \
Date Arithmetic
Date Creation Skupiny funkci

Eunctions and Special Variables:

Abs i

Arsin
Artan
Cos
Exp
Lg10
Ln
Lngamma
Mod
Rnd(1)

skupiny funkei

&

A

e rny

Koritakova: Vicerozmé
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Transformace dat pomoci softwaru SPSS Il

Standardizace dat:

Analyze -> Descriptive Statistics -> Descriptives -> Variables: vybrat
proménnou (napr. vek) -> zatrhnout Save standardized values as variables
-> 0K

Min-max normalizace:

Transform -> Compute Variable -> Target Variable: zadat jméno nové
proménné (napr. vyska_norm) -> Numeric Expression: vybrat proménnou,
kterou chceme normalizovat, a dopsat vzorecek (napf. (vyska-155)/(197-155))

Centrovani dat:

Transform -> Compute Variable -> Target Variable: zadat jméno nové
proménné (napr. vyska_centr) -> Numeric Expression: vybrat proménnou,
kterou chceme centrovat, a pridat minus priimérnd hodnota (napfr. vyska -
172.24)

Odstranéni vlivu kovariat:

Analyze -> Regression -> Linear -> zvolit proménné (napr. cel_cholesterol jako
Dependent, vek... jako Independent(s)); na zdloZce Save zaskrtnout pri
Residuals: Standardized nebo Unstandardized podle toho, co nam vyhovuje
-> Continue -> OK; pripadné Ize vytvorit novou proménnou pomoci Compute
Variable, kterd bude souctem RES_1 a priméru ptvodni proménné

MU ‘:_‘\\L.,.’%
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Transformace dat pomoci softwaru Statistica |

[}

* Logaritmicka transformace:
Oznacit proménnou za proménnou, kterou chceme logaritmovat -> kliknout
pravym tlacitkem mysi -> Add Variables -> Name -> zadat ndzev nové
proménné (napr. vaha_log) -> do Long name napsat =Log(vaha) (Pozor,
v softwaru STATISTICA je prirozeny logaritmus oznacen jako Log(x) misto
Ln(x)!) -> OK

* Standardizace dat:
Oznacit proménnou za proménnou, kterou chceme standardizovat -> kliknout
pravym tlacitkem mysi -> Add Variables -> Name -> zadat ndzev nové
proménné (napr. vek_st) -> do Long name napsat =vek -> OK -> Data ->
Standardize... -> OK

* Min-max normalizace:
Oznacit proménnou za proménnou, kterou chceme centrovat-> kliknout
pravym tlacitkem mysi -> Add Variables -> Name -> zadat ndzev nové
proménné (napr. vyska_centr) -> do Long name napsat =(vyska-155)/(197-
155)(minimum a maximum vypocitané pomoci Descriptive statistics) -> OK

MU ‘:_‘\\L.,.’%
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Transformace dat pomoci softwaru Statistica Il

Centrovani dat:

Oznacit proménnou za proménnou, kterou chceme centrovat-> kliknout
pravym tlacitkem mysi -> Add Variables -> Name -> zadat ndzev nové
proménné (napr. vyska_centr) -> do Long name napsat =vyska-172.24
(primeér vypocitany pomoci Descriptive statistics) -> OK

Odstranéni vlivu kovariat:

Statistics -> Multiple Regession -> zvolit proménné (napr. cel_cholesterol
jako Dependent var., vek... jako Independent variables) -> OK -> OK -> na
zdlozce Save kliknout na Save residuals & predicted -> zvolit proménné, které
bude nové vytvorend tabulka ddle obsahovat -> OK

(pfipadné Ize vytvorit novou proménnou pomoci Add Variables, kde v Long
name bude soucet Residuals a priméru ptvodni proménné)

MU ‘:_‘\\L.,.’%
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Vicerozmerny t-test
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Jednorozmeérny dvouvybeéerovy t-test

Srovndavame dveé skupiny dat, které jsou na sobé nezavislé — mezi objekty
neexistuje vazba.

Priklady: srovnani objem hipokampu u muzl a u Zen, srovnani kognitivniho
vykonu podle dvou kategorii véku,...
2 | %

1 4 I
— —

X1 X2 Pacienti Kontroly

Predpoklad: normalita dat v OBOU skupinach, shodnost (homogenita)
rozptyld v obou skupinach

7 . . X _X _C . a4 7 \'4 4
o Testova statistika: t=— : 2 =, kde s, je vaZend smérodatnd odchylka,
S* n7+7
VM n,

c je konstanta, o kterou se rozdil prameért ma lisit (vétSinou rovna 0)

MU ‘:_‘\\L.,.’%
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Vicerozmerny t-test

Srovndavame dvé skupiny dat, které jsou na sobé nezavislé — mezi objekty
neexistuje vazba.

Na rozdil od jednorozmérného dvouvybérového t-testu jsou dvé skupiny
dat popsany vice kvantitativnimi proménnymi.

0.05-

Koritakova: Vicerozmérné metody - cviceni IBA [w 30



Vicerozmerny t-test

Jednorozmeérny dvouvybérovy t-test: - Studentovo rozdélent

CD_ZHC \de Tmt(ny + ny — 2)

e testova statistika: T =

np ng

_ (np— 1)sp+(ng—1)sg
(np—1)+(ny-1)

« cje konstanta, o kterou se rozdil primeérd ma lisit (vétSinou c = 0)

* nulova hypotéza zamitnuta, pokud |T| > t;_, /,(np +ny — 2)

« 52 jevazeny rozptyl vypoéteny jako s2

Je ekvivalentni testu: _ Frozdgleni
2 ()ZD )EH) c 2 _ — 1 1 -1 — 2
T* = (—) = (kp — Xy — ¢) [5*2 (— + —)] (xp — %y — ¢), kde T*~ F(1, np+n,,-2)
/_+_ nNp Ny
np ny

Vicerozmeérny t-test:
-1
* Hotellingova T2 testova statistika: T2 = (x, — %y — ¢)T [s* (i + i)] (Xp — Xy — C)
np ny
(np-1)Sp+(ny-1)Sy
(nD—1)+(nH 1)
-p—1 T?
p
* nulova hypotéza zamitnuta, kdyz F > F,_,(p,n—p —1) <F rozdelem

* kdeS, je vazena kovariancni matice: S, =
Hotellingovo rozdéleni
* T2~ T%p,n-p-1); pro malé nya n,je lepsi pouiit: F =

> kde n=nytn,,

s W



Ukol 2

» Zjistéte, zda se lisi skupina pacientl se schizofrenii od zdravych subjektd na
zakladé parametr( popisujicich objem mozkovych struktur subjektu.

Objem mozkovych komor

13 |
12 |
11 |

A 01 O N © ©

2 12 5 7
Xp=14 10|,Xyz=13 9
3 8 4 5
¢ e pacienti
e kontroly
°
[
O
[
°
2 3 4 5 6

Objem hipokampu



Ukol 2

» Zjistéte, zda se lisi skupina pacientl se schizofrenii od zdravych subjektd na
zakladé parametr( popisujicich objem mozkovych struktur subjektu.

2 12 5 7
Xp,=|4 10|, Xyz=[3 9
3 8 4 5
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‘ 1 1\
Ukol 2 - fedeni  T*=Go-xu-o[s(i+7)| Go-x-0

Vicerozmérné priméry:

np

H—l Zl 1 Xi1 EZ?£1Xi2]=[4 7]

Vybérové kovariancni matice:

) D ) ]
S. — S11 S12| _[1 -1
D~ |_.D D |~ |_

[S21 S22 -1 4

" H H ) _
S, — S11 S121 _[1 -1
H — | _H H| ™ |_

1S21 S22, -1 4.

Vazena kovarianc¢ni matice:

Se = l—ll _41]



‘ 1 1\
Ukol 2 - fedeni  T*=Go-xu-o[s(i+7)| Go-x-0

D

.
Vicerozmérné priméry:Xp = [3 10], Xy =[4 7] Vazena kovariancni matice:
Pocty subjektl: np =3, ng =3, n=np+ny =6 S, = [_11 _41]
Pocet proménnych: p = 2 Volba parametruc: ¢ = [0 0]

e T O

=541 3 (025 %) (;) = (2415 -05m15) - (1) = (o 1):(1)=05+3 =35
g S 4 s

YYPOCET INVERZNI MATICE ( Poroc’ JEMNOTKOVE HATICE ).

40) (%'% 40)-% (4—4 150 |+
AN (0410505 01 esos/ ~
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‘ 1 1\
Ukol 2 - fedeni  T*=Go-xu-o[s(i+7)| Go-x-0

Vicerozmerne prumery: Vicerozmérny t-test:

Xp = [12?31 Xi1 %Z?Dl Xlzl =[3 10] n (pocet subjektd) 6
Xy = l Zl 1 Xi1 $2?=H1 xizl =[4 7] $z(p0cet proménnych) 3;
F 1,31

Vybérové kovarian¢ni matice: dfl=p 2
S, = _sil s%_ _[1 -1 df2 = n-p-1 3
S21 S22 =1 4 a 0,05

S, = sH sH | _[1 -1 F-crit 9,55
s s =1 4 p-hodnota 0,389

Vazena kovarianc¢ni matice:

Sy = l—11 _41]

MU ‘:_‘\\L.,.’%
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Ukol 2 — redeni v softwaru R

install.packages("ICSNP")
library("ICSNP")
Xd=matrix(c(2,4,3,12,10,8),3,2)

Hotelling's two sample TZ2-test

Xh=matrix(c(5,3,4,7,9,5),3,2)
data: Xd and Xh
. T.2 = 1.3125, dfl = 2, df2 = 3, p-value = 0.389%
HOteIlIngSTz(Xd; Xh) alternative hypothesis: true location difference i= not equal to c(0,0)

Pouziti softwaru R jako kalkulacky:

S=solve(2/3*matrix(c(1,-1,-1,4),2,2)) # vypocet inverzni matice

b=matrix(c(-1,3),1,2) # vektor s hodnotami rozdilu souradnic centroid(l
t2=b%*%S%* %t (b) # vypocet testové statistiky T?

F=(3/2)*(t2/4) # vypocet testové statistiky F

gf(0.95,2,3) # 95% kvantil F rozdéleni pro stupné volnosti 2 a 3
1-pf(F,2,3) # p-hodnota

s W



